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Little Fish in a Big Pond Reveal New Answers 
to Old Questions

Studying the neural control of behavior is a 
challenge. Researchers must consider an animal’s 
environment, past experiences, and motivations. 
Work in relatively simple organisms, for example 
the invertebrate C. elegans, has teased apart the 
neural circuitry of highly stereotyped behaviors, 
like foraging. But in mammals, very little is known, 
“and that’s surprising given just how 
important behaviors like this are,” said Dr. 
Eric Horstick, who studies the molecular 
mechanisms underlying animal behavior.

Horstick, a postdoctoral fellow in 
the NICHD Section of Behavioral 
Neurogenetics, came to the NIH with a 
goal to characterize genes that control 
behavior in vertebrates—information 
that could advance therapies for 
behavior-related diseases in humans. 
He joined the lab of Dr. Harold Burgess, 
whose earlier work studying light-
mediated behaviors in larval zebrafish 
would set the stage for Horstick’s studies.

For more than 20 years, labs have used a classic behavior paradigm in fish called 
the visual motor response (VMR). Investigators place individual larval zebrafish 
into separate wells of a multi-well plate and record larval movement in light and 
dark conditions. With the onset of darkness, the fish move rapidly for several 
minutes in a highly stereotyped response. 

As Horstick considered ways to examine if the movement was random or 
spatially patterned, he realized that the multi-well set up restricted the type and 
resolution of collectable data. According to Horstick, he “blew it up.”  He placed 
individual larva in chambers measuring 400 square millimeters, a roomy space 
for a 3mm creature. This time, when the lights went out, the zebrafish initiated 
a slow, descending spiral, not the rapid motion typical of VMR. Eventually, the 

By Shana R. Spindler, PhD

Dr. Eric Horstick
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Letter from the Editor
When you run an experiment with a well-established method, do you ever 
question if an alternative set up could provide new information? Based on a 
recent publication from the Burgess lab, maybe you should. In our “Hot Off the 
Press” column this month, we delve into the world of zebrafish behavior with 
Dr. Eric Horstick. His modified approach to studying visual motor response elicits 
unexpected swim patterns in the larval fish—driving him deep into the ecology 
literature where he makes fascinating discoveries.

To study fish swim patterns, the Burgess lab creates videos that help visualize 
movements. With increased computer storage capacity and the relative ease of 
recording on mobile devices, video has become a staple in many NICHD labs. In 
some cases, the video is produced as a time-lapse, squeezing hours of filming into 
minutes of presentation. A time stamp can help indicate how much time the video 
spans. In “The Arts” column, Jeremy Swan takes us through a ten-step tutorial for 
adding timecode to a time-lapse video.    

On a final note, we are excited to introduce our new basic science representative 
for the institute, Dr. Suna Gulay. To learn more about Dr. Gulay and her role as the 
NICHD postdoc representative, check out her profile on page 10. 

Enjoy the issue!

Your Editor in Chief,
Shana R. Spindler, PhD

Please send questions and comments for our editor to Shana.Spindler@gmail.com.

VOLUME 8 • ISSUE 83 • APRIL 2017

2

mailto:Shana.Spindler%40gmail.com?subject=


Little Fish in a Big Pond Reveal New Answers to Old 
Questions
(continued from page 1)

zebrafish transitioned from a spiral movement 
into an outward, exploratory pattern. 

“As soon as we gave them more room, 
something much more complex started 
to emerge, a stereotyped behavior,” said 
Horstick. “Beautiful patterns are always 
an attractive component in research.” At 
this point, Horstick left his comfort zone of 
molecular neuroscience to delve into the 
ecology literature, where he found similar 
patterns throughout the animal kingdom. 
His results were consistent with search and 
foraging behaviors observed in mammals 
all the way down to flies and worms. They 
had stumbled upon a highly conserved 
behavioral paradigm that had been masked 
by the confined environment common to VMR 
studies.

Horstick paints an example of this behavior 
in humans. “The scenario I like to describe is 
when you walk out of your house and reach 
for your keys, but they’re not there. Take 
a moment and picture what you do. You 
normally stand there, move your head, scan 
the environment, and step around in a circle 
just like our fish do, just like what worms 
do, just like what flies will do when they’re 
searching for something that they can’t find 
immediately. So even us, when we’re not 
conscientiously aware of it, we perform these 
highly engrained patterns of behavior.”

Horstick now possessed an untapped 
treasure trove of behaviors with the upgraded 
VMR assay. Using the wealth of techniques 
available in zebrafish—including established 
mutants and CRISPR technology—Horstick 
found that zebrafish required eyesight for 
the restricted spiral pattern during VMR. But 
two systems stood out for their involvement 

in the transition to outward movement: 
somatostatin signaling and deep brain 
photoreceptors.

Somatostatin, in particular, piqued Horstick’s 
interests. The small peptide hormone is a 
potent neuromodulator in humans. And based 
on work in mammals, somatostatin serves 
as a regulator of growth hormone output 
and a modulator of behavior states, such as 
anxiety. Horstick ponders, “Is somatostatin 
correlated with feeding drives? This could 
have true relevance to human conditions in 
terms of obesity, drive to eat, drive to seek 
food—maybe with somatostatin we could 
start opening up some of those angles?” 
 
In the near future, Horstick hopes to gain 
insight into the somatostatin neurons involved 
in this behavior to elucidate the circuitry 
further. He questions how these neurons 
tie into the input of sensory information to 
then modulate downstream motor output. 
But Horstick’s goals don’t stop there. His big 
question: “Is this peptide tuning not just this 
behavior, but behavioral states as a whole?” 

Stay tuned.

PHOTO BY URI MANOR
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3...2…1… Timecode!
By Jeremy Swan

(continued on page 5)

In our last two articles of “The Arts” column, we created time-lapse 
videos in both Photoshop and After Effects. Now, let’s add a “time 
stamp” to show the precise time each image was captured. Spoiler: 
It involves keyframes and nesting. In this article, we present a ten-
step process for adding timecode.

“Nesting—Not Just for the Birds, But Fish Too” is required 
reading before continuing with this article. Caught up? Great!

SETTING UP TO ADD TIMECODE TO A TIME-LAPSE VIDEO
First off, let’s grab our example video, which can be downloaded 
here: timelapse-after-effects.mp4 

Drag the video into the “Project” window to add it to your project. 

Right click on the video and choose “New Composition from Selection” 

This makes a composition that automatically has the same frames 
per minute, length of time, height, and width of the video file.

It’s time to add a timecode label.

Launch and prepare an After Effects project

Modifying text to make it readable

1.

2.

On the top menubar, click: Layer > New > Text. 
Begin typing to place text on the layer.

To modify the type of font (A) and color 
(B), click “Command + a” to select the text 
and make your color and font selection.

Ensure that your text is readable by 
scrubbing through the footage (grab the 
handle and drag to the left/right).

To make the text stand out more, you 
can add a stroke by clicking the box next 
to the text color (C). Adjust the stroke 
width (D) as necessary.

A B
C

D
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3...2…1… Timecode!
(continued from page 4)

(continued on page 6)

Adding a solid block of color behind text

Finding the right font for timecode-specific text

3.

4.

If your text is still difficult to see, you can add a block 
of color behind the text by clicking Layer > New > Solid

Position the layer in between the text and 
background layers. You can also change the 
opacity to make it more discreet.

You can click the box and drag it around to move 
the position and change the size by adjusting the 
handles (after you begin to change scale, press 
the shift key to maintain the original ratio). Note: 
You can use this as simple “text” or continue to 
the following step to create the timecode.

If you would like to use a different font for the 
time, be sure that the font is “fixed width.” This 
means that the characters are all the same width, 
so that the text will not jump around as the clock 
progresses. (Note: The “Crystal” font is for all-
caps and numbers only, so if your text contains 
lowercase letters, they will be displayed with 
another font.)

For a timecode layer of text, I’d recommend using 
“Crystal” (available as freeware here: http://www.
fontspace.com/allen-r-walden/crystal).
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3...2…1… Timecode!

(continued on page 7)

(continued from page 5)

Create the “stop watch” effect5.
Open your “Effects and Presets” window and 
open “Expression Controls”

Drag “Slider Control” over your text, or onto 
the text layer in the timeline, to apply the 
effect. You should now be able to click 
the arrows to see “Slider Control” in your 
timeline.

Hold the Option key down while clicking on 
the stopwatch icon to display the expression 
editor on the right.

Paste the following code into the expression 
editor: 

This code is shared here: https://github.com/anbdesign/
After_Effects_Expressions/blob/master/Keyframe_
Controlled_Countdown_Timer.txt

function padZero(n){
	   if (n < 10) return "0" + n else return "" + n
	 }
	  
	 t = Math.floor(effect("Slider Control")("Slider"));
	 hr = Math.floor(t/3600);
	 min = Math.floor((t%3600)/60);
	 sec = Math.floor(t%60);
	 /*
	 delete the comment tags and put in one line to add hours
	 padZero(hr)+":"+            */
	  
	 padZero(min)+":"+padZero(sec)

/* Script written by Josh Vickerson | https://twitter.com/joshvickerson */
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3...2…1… Timecode!

(continued on page 8)

(continued from page 6)

Set the time for the beginning of the time-lapse (in seconds)6.
In the sample, Dr. Fabio Faucz (Stratakis lab) captured the images every 10 minutes, 
starting at 90 minutes, until a total of 150 images had been collected. This means that we’ll 
need to start at 1:30 and end at 24 hours. Converting to seconds, that is 5400 and 86400.

On the Timeline, move the playhead to the first frame and enter 5400.

You’ll see that it says 30:00 because hours 
aren’t calculated in the code. Let’s fix that. 
Click in the “Expression Source Text” code 
window and delete the comment tags and 
the comment, shown in blue.

These comment symbols—/*  and  */—
cause everything in between to be ignored 
so that programmers can “toggle” parts of 
the code on and off and leave comments 
within the actual code.

The result should look like this:

Once you’ve clicked off the code 
window, you’ll see the extra set of 
numbers displaying 01:30:00.



move 
playhead

change 
valueu u
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3...2…1… Timecode!

(continued on page 9)

(continued from page 7)

Setting the length of the timeline

Setting the frames per second

7.

8.

We will set a “Keyframe” at the beginning and the 
end of the timeline. Keyframes are used to define 
the start and end points of a transition, so that the 
frames in between can be calculated automatically 
for a smooth transition between each keyframe. 
With the playhead still at the beginning of the 
timeline, click the stopwatch icon. This will add a 
keyframe at the playhead, which is represented by 
a blue diamond shape. Note: Clicking the Stopwatch 
icon a second time will remove all keyframes.

Now, let’s move the playhead to the end of the 
video (50 seconds) and change the slider value 
to 86400. A new keyframe will automatically be 
inserted in the timeline.

We’re almost there… This would be 
perfect, except that each image in the 
time-lapse lasts for 10 frames, meaning 
that a new value is displayed for each 
of those 10 frames. Let’s fix this by 
reducing the Frames Per Second (FPS) 
to match the exact number of images.

The original movie was created from 
150 images at a rate of 3 frames per 
second (FPS) for a total of 50 seconds. 
We exported at 30 frames per second 
(or 29.97, since that is the standard that 
works well on YouTube and is preferred 
by video editors). Doing that math, 
each image is displayed for 10 frames, 
but we can change this: Right-click on 
the composition in the project window, 
and change the FPS to 3 FPS.

When you scrub through the footage, 
the seconds (:00 at the end) should 
remain constant.
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3...2…1… Timecode!
(continued from page 8)

Finishing touches

Hiding the last two digits

9.

10.

Now for some finishing touches. 
Let’s add an outer glow to make 
the text more readable against 
the background. Right-click the 
Timecode Layer and select Layer 
Styles > Outer Glow.

We can use a mask to cut off 
the last two digits by right-
clicking on the timecode layer 
and choosing “New Mask.”

Click the handles and move 
them around to exclude the 
“seconds” column.

Your movie should be ready for export! 
You can follow the instructions from the 
previous article or click File > Export > Add 
to render queue. Your result should look 
something like this: timelapse-timecode-
after-effects.mp4.

You can change the color (I like 
neutral colors like white and 
black) and other parameters, 
such as “spread” and “opacity” 
to find the perfect balance. It 
should be SUBTLE!

VOLUME 8 • ISSUE 83 • APRIL 2017

9

https://science.nichd.nih.gov/confluence/x/V4ZUBw
https://science.nichd.nih.gov/confluence/download/attachments/124422280/timelapse-timecode-after-effects.mp4
https://science.nichd.nih.gov/confluence/download/attachments/124422280/timelapse-timecode-after-effects.mp4


Meet Dr. Suna Gulay, Our New Basic 
Science Postdoc Representative
Our basic science representative is a postdoctoral fellow who 
serves on the NIH  Fellows Committee (FelCom) on behalf of the 
institute's fellow population. In general, most institutes have 
one basic science representative and one clinical representative. 
Representative appointments last for 12 months and can be 
renewed for an additional year.

Responsibilities of the institute’s representative include 
attending all scheduled FelCom meetings, participating on a 
subcommittee, disseminating information to the fellows in the 
institute communicating fellow’s concerns to the Committee, and 
coordinating the distribution of information via subcommittees. 
In NICHD, our representatives also work closely with the Office 
of Education to plan events for all NICHD postdoctoral trainees.

If you would like more information about serving as a basic 
science or clinical postdoctoral representative, please contact Dr. 
Yvette Pittman (yvette.pittman@nih.gov), and for information 
about serving on a FelCom subcommittee, contact one of the 
committee chairs directly.  

A BIT ABOUT DR. GULAY
I am originally from Turkey, where I received my bachelor’s 
and master’s degrees. I worked in a variety of fields, from 
biotechnology to cancer biology, before coming to the University 
of Maryland, College Park, for my doctoral studies. I conducted 
my dissertation research in Dr. Jonathan Dinman’s laboratory, 
probing the ribosomal RNA secondary structure throughout 
protein translation elongation cycle. I met my current NIH 
mentor, Dr. Alan Hinnebusch, at a conference and collaborated 
with him on a project before joining his laboratory as a 
postdoctoral fellow. Currently, I am interested in the functional 
interactions between a eukaryotic translation initiation factor 
complex, eIF4F, and an RNA helicase known to regulate 
translation initiation of a subset of mRNAs in yeast, Ded1.

(continued on page 11)
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I am not all business and, in my spare time, love going on hikes with my 
husband and friends, visiting small towns, and trying different cuisines 
(looking into Uyghur cuisine next). At home, I enjoy cuddling with my cat 
(when he is in the mood ☺).

While I would like to advance into a combined teaching and research 
career in a primarily undergraduate institution, I believe one should keep 
their options open. The many resources NIH and NICHD offer have shown 
me the variety of career options available to biomedical scientists. As I 
assume the role of NICHD Basic Science Representative, I am excited to be 
in a position to pay it forward and help other fellows—working alongside 
Dr. Yvette Pittman to develop and improve tools that enrich postdoctoral 
training at NICHD.

I would like to encourage all NICHD postdoc fellows, both IRTAs and Visiting 
fellows, to consider joining the Fellows Advisory Committee (contact Dr. 
Yvette Pittman, yvette.pittman@nih.gov, for more information). This is 
an excellent way to let us know about your training needs, as well as to be 
the first to hear about new tools, grant opportunities, and workshops. You 
get to have a voice in the process that produces training activities, from 
planning to execution. Please feel free to email me at suna.gulay@nih.gov, 
especially for issues and ideas regarding FelCom activities.

Meet Dr. Suna Gulay, Our New Basic Science 
Postdoc Representative
(continued from page 10)
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Pi Day
Pie Competition

MARCH 21, 2017

Left to right: People's Choice winner Pranati Panuganti (Samosa Pie); 
Best Savory Pie winner Vincent Black (Crab Pie); Dave Songco, NICHD 
CIO; Second Place winner Erin Goldstein (Chai Strawberry-Blueberry 
Pie); Third Place winner Angela Wish (French Silk Chocolate Pie).
Not pictured: First Place winner Debbie Brock (Samoa Pie)
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April Announcements

(continued on page 14)

A NEW GRANT OPPORTUNITY FOR NICHD POSTDOCS 
AND CLINICAL FELLOWS 

DIR is launching a competitive research funding opportunity for 
NICHD postdoctoral, visiting, and clinical fellows—Intramural 
Research Fellowships (IRFs). Its main objective is to promote 
grant writing among our intramural trainees while enhancing 
awareness of various application components for an NIH grant. 

These research fellowships are specifically for NICHD intramural 
fellows within their second and third year of training, preparing 
them for the entire process of applying to an NIH grant. We 
ask that the fellows prepare the applications, but mentors are 
expected to offer guidance and input throughout the writing 
process. Using the NIH scoring system, a panel of our Board of 
Scientific Counselors will review all of the applications.  

For applications that result in an award, the appointed lab will 
receive $30,000 for one fiscal year (FY2018), to use toward 
the fellow’s stipend, equipment, and/or travel to a scientific 
conference related to their proposed work. 

The application deadline is August 1, 2017, and the required 
sections are listed below:

»» Biographical sketch for the fellow 
»» Specific Aims for 1 year of training 
»» Budget Justification 
»» Significance and Approach 
»» Statement of Support from the NICHD mentor

Pi Day Key
(continued from page 12)
1. Nigerian Meat Pie
2. French Silk Chocolate
3. Samosa Pie
4. Milk Chocolate "Pi"can Pie
5. Samoa Pie
6. DB's Famous Appleberry
7. Chai Strawberry-Blueberry
8. Mexican Chocolate Tofu

9. Strawberry Coconut Cream
10. Banana Cream Pie
11. Bacon Maple Walnut
12. Coconut Pie
13. Lemon Meringue
14. Double Peanut Pie
15. Try Me Ricotta Pie
16. Crab Pie
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April Announcements

(continued on page 15)

(continued from page 13)

ANNUAL NICHD FELLOWS RETREAT IS NEAR: MAY 1, 
ALL-DAY EVENT

Speaker profiles, meeting agenda, and poster information 
can be found on the retreat website. Registration is now 
closed. 

If you are interested in covering any part of the meeting 
for The NICHD Connection, please contact our editor Shana 
Spindler at Shana.Spindler@gmail.com. See you there!

GRANT WRITING TRAINING SESSION FOR 2017 IRF APPLICANTS, 
MAY 15 AT 2PM

For all prospective applicants, the Office of Education will offer a 
training session on Monday, May 15, at 2 p.m. in Bldg. 31, conference 
room 2A48 (A-wing, 2nd floor).  We will cover various components of 
an NIH grant, details about the application and review processes, and 
tips on preparing an IRF application.
Attendance at this training session is a requirement for submission.

FOR ALL NICHD FELLOWS: “RESUME HOUR” OFFERED
Every Wednesday, 1–2 p.m., Building 31, Room 1B44, or you can 
schedule an individual session for another day and time 

Do you need some tips on putting together an excellent resume or CV 
for your ideal job? Learn how to perfect your application documents 
during our weekly office hours. Don’t miss this unique opportunity to 
review your resume or CV in great detail with Dr. Pittman.

You will:
»» Learn about keywords and tailoring for specific jobs
»» Examine various samples
»» Review formatting
»» Establish what to include—and not to include 
»» Identify your target audience

And much more!
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April Announcements
(continued from page 14)

SAVE THE DATE: POSTBAC FAREWELL, MAY 24 AT 3:30 PM
Please save the date of Wednesday, May 24, from 3:30 to 4:30 
p.m. for our postbac farewell event. We will announce our three 
2017 Postbac Poster Day winners for our institute, raffle off gifts 
from the R&W store, and enjoy some good desserts. 

Mark your calendars! More information to follow.

WRITE WINNING NIH GRANT PROPOSALS, THIS SUMMER
Thursday, July 13, 2017
9:00 a.m. – 1:30 p.m.

This workshop will address both practical and conceptual aspects 
that are important to the proposal writing process. Attendees will 
receive the “Grant Writer’s Workbook”—an invaluable, up-to-date 
reference tool for those who intend to write NIH grant proposals. 
It includes topics such as how to prepare a compelling Specific 
Aims page—many reviewers believe this is the most important 
section of your grant application.

For more information or if you would like to register early, please 
contact Dr. Yvette Pittman at yvette.pittman@nih.gov.

(continued on page 16)
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April Announcements

(continued on page 17)

DON’T FORGET! FELLOWS INTRAMURAL GRANTS SUPPLEMENT 
AWARD ONGOING

Grant writing is important for professional development during your 
postdoctoral training.

The objective of the NICHD FIGS program is to encourage fellows in the 
Division of Intramural Research to apply for competitive funding from 
intramural NIH or outside organizations and agencies, in order to develop your 
skills in grantsmanship and in support of your career development. Award 
recipients are also contributing to the DIR by bringing in additional funding 
and resources, and as such merit recognition from the institute.

ELIGIBILITY: 
Postdoctoral, visiting, and clinical fellows of NICHD

TERMS:
The grant for which the fellow applies must be for a competitive award of 
$30,000 or more.  The fellow must be the primary applicant on the grant 
application; or, in exceptional cases, the co-investigator.

AWARDS:
The Scientific Director must sign off on submissions prior to them going 
forward (see NICHD Grants Administration Policy). The fellow must provide 
confirmation of receipt of the application by the awarding agency to the Office 
of Education.

A $250 one-time stipend increase (limited to 2 applications maximum per 
year), is processed at the time of the fellow’s renewal. For applications that 
result in an award, the fellow receives a one-time $1,000 stipend increase.

All stipend increases will be funded centrally through the Office of Education, 
typically at the time of the fellow’s renewal. In the case of a trainee on an 
FTE appointment, a one-time award will be made, in lieu of the stipend 
increase, subject to the NIH Office of Human Resources approval of the award 
justification.

Note: For the Japan Society for the Promotion of Science ( JSPS) fellowship, FIGS 
applies only when an application is submitted and not if it results in an award.

(continued from page 15)
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April Announcements

MENTOR OF THE YEAR: ACCEPTING NOMINATIONS NOW!
The time has come for you to nominate your fellow or PI for the 
2017 NICHD Mentor of the Year Awards. This is your chance to 
recognize an individual in the Division of Intramural Research (DIR) 
whose mentoring has made a difference in your life at the NIH!

Information about the NICHD’s two annual intramural Mentor 
of the Year Awards, one for a fellow and one for an investigator 
is located on the NICHD fellows wiki. Please submit your 
nomination form and a 500-word (maximum) narrative 
electronically to Dr. Yvette Pittman at yvette.pittman@nih.gov. 
The submission deadline is Monday, May 8th.

Contact the Office of Education, if you have any questions about 
the nomination instructions and selection process.

POSTER JUDGES NEEDED FOR POSTBAC POSTER DAY: MAY 4
Please contact Dr. Yvette Pittman at yvette.pittman@nih.gov if 
you would like to help judge the NICHD postbaccalaureate fellows' 
posters this spring. We would like to recruit seven postdoc and 
graduate student judges—to visit about five posters each and attend 
a meeting to select the three “best poster” winners for 2017. This is a 
great learning experience for both the judges and postbac trainees! 

For more information about the Postbac Poster Day, please visit 
https://www.training.nih.gov/postbac_poster_day.

(continued from page 16)
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April Events
THURSDAY, APRIL 27, 9 AM – 4 PM

23rd Annual NIH Take Your Child to Work Day

Inspire the next generation of NIH daughters 
and sons in grades 1–12  to explore career 
paths in science and public service at our 
nation’s medical research agency!

For registration information, please visit 
http://takeyourchildtowork.nih.gov.
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